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1. Introduction 

The TechDoc Client is a desktop application that allows you to perform most of the basic 
TechDoc operations along with various mass document operations. The TechDoc client 
is part of the DocuBrain family of products. 
 
Upon connecting to a Document Manager, all of its folders and documents that are 
accessible to you are displayed in a Windows Explorer type of interface. For the most 
part, performing operations in the TechDoc Client should be a familiar experience as 
most of them look, feel, and function very similar to the operations you perform in 
TechDoc using a web browser. 
 

2. New Concepts 

The TechDoc Client can perform many of the functions that can be done from a web 
browser but it also comes with some exciting new features. It is a good idea to read over 
this section and get familiar with these new features so that you will be able to take full 
advantage of the TechDoc Client has to offer. 
 

2.1. Bulk Loading 

Have you ever had to go through the daunting task of creating dozens, hundreds, or 
thousands of documents that are all similar in nature? The TechDoc Client can now help 
make this a much easier task with the ability to bulk load documents. Bulk loading 
documents means that you can create many documents while only having to go through 
the create document process one time. More details on bulk loading are provided in 
section 5.2. 
 

2.2. Drag and Drop 

The TechDoc Client allows one or more documents and/or folders to be bulk loaded to 
the Document Manager using Windows-style Drag and Drop functionality. You simply 
select the folder that you want to upload the documents to in the left panel of the client 
and then drag and drop the desired documents and/or folders (from your desktop, from 
a folder in your Windows Explorer, etc.) into the right side panel of the client and the 
document creation process will begin. More details on bulk loading are provided in 
section 5.2. 
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2.3. Profiles 

You can think of profiles as templates that will help pre-fill the data for you when 
creating documents. Let's say that once a month, you receive a hundred As-Run 
documents from the previous month that you need to load into TechDoc. All of these 
documents always come from the same organization and all have the same document 
type and document category. Because they are As-Run documents, they must also have 
numerous keywords pertaining to the origin of the document, the contract number, etc. 
Before the TechDoc Client, this would have been quite time consuming; but now it can 
be done much easier and faster with the use of the TechDoc Client and profiles. 
 
Creating a profile is exactly like the create document process except that there are no 
required fields except for a name for the profile. Once the process is completed, the 
fields that were entered are saved in the profile. 
 
To continue with our example from above, we could create a profile called As-Run with 
the organization, document category, document type, and keywords all entered. Then 
each month when you need to load As-Run documents, you would simply select the 
As-Run profile and each time you start to create documents the organization, document 
category, document type, and keywords will all be pre-filled for you. By using Bulk 
Loading and Profiles, you can almost completely automate the create document 
process, even when creating thousands of documents at a time. More details on profiles 
are provided in section 5.4. 
 

2.4. Search Folders 

Search folders are a handy new feature that can help you create a "virtual" folder of 
documents that all match a stored set of search criteria. A search folder is used to group 
a set of documents even if they reside in different TechDoc folders on the Document 
Manager. Every search folder that is created will be placed in the "Search Folders" folder 
so that it can be accessed just as a normal TechDoc folder can. 
 
If you often want to access all the documents that you own in the Document Manager, 
you can create a search folder called "Documents I Own" and select yourself for the 
owner in the search criteria. Then when you click on the "Documents I Own" search 
folder, the TechDoc Client will search the Document Manager and return all of the 
documents that you currently own. More details on Search folders are provided in 
section 5.5. 
 



  PTI-TD-00009 
  Revision 10-1 

TechDoc Client Guide  3 
 

3. Getting Started 

This section describes the basics to get you up and running with the TechDoc Client. If 
you haven't already, install the TechDoc Client by double-clicking on the setup program. 
It's easy because the TechDoc Client requires no special privileges or access to your 
computer so it can be installed without Administrator privileges. 
 

3.1. Making a Connection 

In order to connect to a Document Manager, a connection must be created that 
specifies the information needed to connect with that Document Manager. The TechDoc 
Client stores each of the connections that you create along with various pieces of 
information that are specific to only that connection (i.e. document profiles, search 
folders, etc.). 
 
When the TechDoc Client first launches, it will prompt you with the Connect dialog. 
Using this dialog, select the host (Document Manager) that you wish to connect to and 
work with. If you authenticate on this Documents Manager with a traditional TechDoc 
username and password, the username will be displayed and the corresponding 
password should be entered. If you authenticate via Single Sign-On (SSO), a browser will 
launch when the Connect button is clicked and direct you to the site where you normally 
log in when using the selected Document Manager. Click the Connect button to open 
the connection. If you have not created a connection yet, click the Manage button and 
refer to the following subsections. 
 

3.1.1. Creating a Connection 

To create a connection, on the Manage Connections dialog, click the New button. On 
the Create Connection dialog, enter the host name of the Document Manager that you 
wish to connect to. You should always use the fully qualified host name of the server 
running TechDoc; such as 'techdoc.example.com' without the quotes. If you normally log 
in with Single Sign-On (SSO), check the box next to Connect using Single Sign-On. If you 
still use a traditional TechDoc username and password, enter them in their 
corresponding boxes. Select whether or not to use HTTPS (HTTPS is a secure connection 
and is normally required) when connecting to it. 
 
If you are required to use a proxy when using the internet (normally this is not required 
and should be left blank), enter the information for the proxy server; the proxy server 
should be entered at 'host:portnumber' without the quotes such as '127.0.0.1:8888' or 
'proxy.example.com:8888'. 
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If for some reason, you have an extremely slow connection to the Document Manager 
because of network congestion, connection limitations, etc., the timeout may be 
adjusted to help with this (normally this should be left at the default). The timeout 
specifies the number of seconds that the client will wait to hear back from the server 
when performing a request such as showing a document, loading the documents in a 
folder, etc. By default, the timeout is set to 30 seconds and should be more than 
adequate for most situations.  
 
Once all of the connection information has been entered, click the OK button to test and 
save the connection. Please note that the TechDoc Client will never store your 
password; it is only used here to verify your connection information is correct. 
 

3.1.2.  Editing a Connection 

To edit a connection, on the Manage Connections dialog, select the connection to edit 
and click the Edit button. On the Edit Connection dialog, edit the information necessary 
and click the OK button to test and save the connection. Please note that the TechDoc 
Client will never store your password; it is only used here to verify your connection 
information is correct. 
 

3.1.3.  Deleting a Connection 

Deleting a connection from the TechDoc Client also deletes all the associated data for 
that connection (i.e., search folder settings, profiles, etc.). To delete a connection, on 
the Manage Connections dialog, select the connection to delete and click the Delete 
button. 
 

3.2. Navigation and Interaction 

After you've connected to a Document Manager, the folder tree will be displayed. It's 
important to note that some folders of the Document Manager will not be accessible if 
you do not have read access to them. Navigation in the TechDoc Client works just like 
the Windows Explorer, clicking on the plus or minus sign next to a folder expands or 
collapses the folder, respectively, and clicking on a folder displays its documents in the 
right panel. Keep in mind that you are remotely connected and it can take some time for 
the information from large numbers of folders or documents to be downloaded from 
the server. 
 
Most of the basic TechDoc document operations are available in the client. The 
operations are accessed by using the File menu, toolbar, or right click menu of a folder 
or document. For example, to show the information on a folder, select the folder and 
then choose "Show Info" from the File menu, or click the  icon on the toolbar, or right 
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click on the folder and select "Show Info". The client will then download the folder's 
current information from the Document Manager and display it to you. 
 
Many operations are small and basic and therefore will execute quickly while others can 
take much longer due to their size and complexity. Most operations are only available 
when a single folder or document is selected. However, several operations support 
multiple documents. If you select two or more documents and then right click on them, 
you will see the multi-document operations that are available. 
 
While you click around through the folder tree, folders and documents are reloaded 
periodically from the server. It is possible that at any given moment, a folder or 
document may be modified by another user and the client may not have reloaded the 
information yet to reflect that change. As a convenience, a refresh operation has been 
added to allow you to reload your current view of the folders and documents. When 
necessary, you can click the  icon on the toolbar or select Refresh from the View menu 
to immediately reload the folder tree and document information from the Document 
Manager that you are connected to. 
 

3.2.1. Fast Switching between User Accounts 

Starting with TechDoc 9, a new feature called Fast Switching was introduced. If you 
Single Sign-On to a TechDoc 9 or higher Document Manager and you have more than 
one TechDoc user account tied to the same Single Sign On account, you can now fast 
switch between the accounts. 
 
Once you connect to a server and the conditions above are met, you will see a Fast 
Switch dropdown on the far-right side of the menu bar of the TechDoc Client (just above 
the profile dropdown) that has the current TechDoc user name in it. At any time, you 
can click on the Fast Switch dropdown and change to one of the other users associated 
with your Single Sign On account. The username on the title bar will change and now 
you will be accessing TechDoc as the other user. 
 

4. TechDoc Operation Changes 

In this section, we'll discuss the TechDoc operations that perform differently than what 
you may be used to seeing when using TechDoc with a web browser. 
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4.1. Associate Access and Mail 

The changes for associate access, associate notification, and associate distribution apply 
when you have selected multiple documents to associate at the same time. Currently, 
the TechDoc Client only supports associating access and mail for one folder at a time. 
 
Say that we have 500 newly created documents to which we want to associate the 
group named "Logistics" with Reserve/Replace access. First, you would select the 500 
documents in the client, right click on them, and choose Associate Access. The client will 
now start to download the current access settings for the 500 documents. If you look at 
the lower left corner of the client window, you'll see the message "Retrieving associated 
access of documents" and a progress bar that indicates that the client is working. Any 
time the client performs an action that may take a little time, it will display a message 
and progress bar to let you know that it's working on your request. 
 
After the current association information has been downloaded, the Associate Access 
window will display all the groups, users, and remote users currently associated to the 
selected documents. Enter a reason and click Next to continue. On the next screen 
select the group "Logistics", check the reserve/replace access setting, click the Add 
button, and click Next to continue. On the next screen, click Next since we are not 
associating any users. Finally, on the Remote Users screen, click OK to start the 
association process. The client will begin associating each of the 500 documents with 
the reserve/replace access to the group "Logistics". If you look at the lower left corner 
of the client window, you will see the message "Associating access for documents" until 
the job completes. 
 
Association in the client works with the idea of accumulating all of the associated 
access, notification, or distribution settings of the documents you are working with. For 
example, let's say that we have 30 documents that we are going to associate notification 
for. The first ten of these documents do not have any groups, users, or remote emails 
associated with them. The second 10 documents already have a group "TestUsers" 
associated for notification. The last 10 documents already have a user "John" associated 
for notification. If you select the 30 documents and click Associate Notification, the 
client will load the associated notification settings of the 30 documents and combine 
them all together. When the Associate Notification window comes up, it will appear that 
all 30 documents have the group "TestUsers" and the user "John" currently associated. If 
you continue through the dialog not making any other changes, the client will associate 
the group and user with all 30 documents. 
 
It's also important to note that when associating access of documents, the documents' 
category/categories come into play. Since associate access also sets the read access of 
the documents, the client has to determine the highest read access setting that will be 
allowed for the given group of documents. The highest read access setting of a 
document is determined by what its doc category allows. Let's say you have 20 
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documents; 10 documents have a doc category that allows Global read access while the 
other 10 documents have a doc category that only allows Community read access. If you 
attempt to associate access to the 20 documents, the client will only allow the read 
access to be set as high as Community for all 20 documents. 
 
There are two important things to remember when performing associations on multiple 
documents. First, after associating access, notification, or distribution for a group of 
documents, all of the documents will have the exact same access, notification, or 
distribution. Second, when associating the access of a group of documents, you will only 
be able to set the read access as high as the lowest document category allows. 
 

4.2. Delete 

Deleting a folder or document in the TechDoc Client works the same as it does from a 
web browser, you must have the privilege and access to delete the folder or document 
and in the case of a folder, the folder must be empty. The client does allow you to 
delete multiple documents at once by selecting all of the documents, right clicking on 
them, and selecting Delete. The same rules apply; you must have delete privilege and 
access to all of the documents that you are attempting to delete. Let's say you select 
100 documents to delete and only have delete access to 50 of them. The client will 
inform you that only 50 of the 100 documents can be deleted and give you the option to 
continue. If you do continue, the client will only delete the 50 documents that you are 
allowed to delete. 
 

4.3. Showing Generations 

Because of the Windows Explorer design, the TechDoc Client does not use the main 
window to display generations. In order to view the generations of a document, right 
click on the document and select "Show Generations". 
 
The Document Generations window will display all of the generations for the selected 
document and allow you to access all of the generation-specific commands. Note that 
some operations apply only to native generations while other operations apply only to 
rendered generations. To access any of the generation operations, right click on a 
generation and a popup menu will be displayed showing the available operations. 
 

5. New Functionality 

In this section, we'll discuss the new capabilities of the TechDoc Client and some of its 
great time saving features. If you come up with any new ideas, we'd like to hear them.  
See section 6 for details on providing us with your feedback. 
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5.1. Save As 

"Save As" is a new feature in the client that allows you to select one or more documents 
and download all of them at once. After selecting the document(s) and clicking "Save 
As...", the "Save As" window will display. Then you select where to place the 
document(s) on your computer and which generations of the documents to download 
(either the latest generation or latest revision, and native or rendered). After clicking the 
Download button, the client will first retrieve all of the information about the files to 
download. Next, the Downloads window will pop up to display the status of the 
download as the files are downloaded to your computer. 
 
The Downloads window tracks the progress of all downloads started during a TechDoc 
Client session. Download jobs are only processed one at a time, so you to perform 
multiple "Save As..." operations, multiple download jobs will be created and queued in 
the Downloads window. The Downloads window allows you to right click on a single 
download and perform various operations depending on the state of that download. If 
you right click on a download that has completed, you can click open and your computer 
will open that file. If a download should fail for any reason (i.e. your network connection 
briefly goes out), you can right click on a failed download and click retry to attempt to 
re-download it. 
 
You can close the Downloads window at any time and the downloads will continue to 
run in the background. If you wish to view the Downloads window, click "Show 
Downloads" under the View menu on the client's main window. 
 

5.2. Bulk Loading 

Bulk loading is used to create one or more documents and/or folders via the TechDoc 
Client. To start the creation process, navigate to the folder where you wish to create the 
document(s) and/or folder(s) in the TechDoc Client. After navigating to the folder, either 
select "Create Document" from the file menu, right click on the folder, select "Create 
Document", click the  icon on the toolbar or drag and drop the files and/or folders to 
be uploaded onto the client. If you use one of the first three (non-drag and drop) 
methods, you will be presented with the Open window where you select the file(s) to be 
bulk loaded. 
 
Next, the Create Document window will be displayed. The window looks and functions 
very similar to the Create Document process when using a web browser. If you've 
started the document creation process with a single file, you will only be creating a 
single document and the rest of this procedure is just like the web browser. 
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Here's what happens when multiple files are used. The Create Document window works 
similar to the web browser experience, but there is one exception. The document 
number field has some special abilities. Normally when you create a document, you 
would just enter a document number and move on. When creating multiple documents, 
there are two special functions you can utilize in the document number field: client 
auto-numbering and server auto-numbering. 
 

5.2.1. Client Auto-Numbering 

The first function is client auto-numbering. Client auto-numbering works by utilizing 
special codes that begin with percent signs in the document number mask to identify 
computed values that should be inserted into each document number as it is being 
created. 
 
Client auto-numbering uses the same codes that server auto-numbering does. The 
reason for having client auto-numbering is that it allows you to use a different 
document number mask for each set of documents you upload, rather than sharing the 
same one as everyone else when using server auto-numbering. 
 
The following is a list of the codes that can be used for client auto-numbering: 
 

%H The two-digit hour of the current time. 

%M The two-digit minute of the current time. 

%S The two-digit second of the current time. 

%L The three-digit millisecond of the current time. 

%m The two-digit month of the current date. 

%d The two-digit day of the current date. 

%y The four-digit year of the current date. 

%Y The two-digit short year of the current date. 

%u The username that you are currently connected to the server with. 

%#  An auto-generated sequence number. More pounds signs are added for more 
digits. For example, %##### specifies a five digit sequence number that will 
be zero-padded on the left, if necessary. 

%f Use the filename (minus the extension) as the document number. %f cannot 
be used with any other codes or text. 

 
 
For example, if we were creating 20 As-Run documents, we could enter 
"AS-RUN-%y-%###" without the quotes. In this case, the client would then create the 
documents in a sequential order starting at one. Assuming the current year is 2011, you 
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would end up with 20 documents named: AS-RUN-2011-001, AS-RUN-2011-002, 
AS-RUN-2011-003, …, AS-RUN-2011-019, and AS-RUN-2011-020. 
 
When using client auto-numbering, there are two important things to remember. First, 
you must use enough pound signs for the given number of documents: %# for 8 
documents, %## for 91 documents, %### for 605 documents, etc. It is acceptable to use 
more pound signs than there are digits in the number of documents. This will result in 
extra leading zeroes. Second, the fixed prefix portion of the auto-number must not be in 
use on the Document Manager. For example, you wouldn't have been able to perform 
the example above (AS-RUN-%y-%###) if any other documents already existed in the 
same Document Manager with a document number of AS-RUN-2011- followed by any 
three digits. A good practice to avoid this situation is to include the date and time (i.e. 
AS-RUN-%y%m%d-%h%m%s-%#####), or a "batch number" in the document number 
(i.e. AS-RUN-0001-%##### for the first batch, AS-RUN-0002-%##### for the second 
batch, etc.).  
 
When using the %f code, no other codes may be used nor can any additional text be 
used. If the %f code is being used, it can be the only thing entered into the doc number 
field. For each document being created, the client will use the filename for the 
document number minus the extension. The last period is used when determining 
where the extension begins. If you uploaded a file with the name MyExampleFile.txt, the 
client would strip the extension and the document would be created with 
MyExampleFile as the document number. Since document numbers must be unique, the 
client will not allow you to upload two files with the same name but different extensions 
(like MyExampleFile.txt and MyExampleFile.doc) because they would resolve to the 
same document number (MyExampleFile) and collide. 
Additionally, the filenames must not already exist as document numbers in the 
Document Manager. The client will check each filename against the already existing 
document numbers in TechDoc. If a collision is detected, the client will let you know. 
You will have to rename the file(s) so that the name portion of the filename results in 
document number(s) that are not currently in use before attempting to upload them 
again. For example, if you attempt to upload MyExampleFile.txt and the document 
number MyExampleFile already exists; you could rename the file to MyExampleFile2.txt 
and try again. 
 

5.2.2. Server Auto-Numbering 

The second function is server auto-numbering. It is important to note that auto-
numbering must be enabled on the Document Manager that you are connected to for 
server auto-numbering to work from the TechDoc Client. Server auto-numbering works 
in the client just like server auto-numbering works when using TechDoc via a web 
browser. You simply leave the doc number empty and the server will generate a unique 
number for each document that is bulk loaded. 
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5.2.3. Bulk Loading Folders 

One or more folders can be dragged onto the client. For each folder that is dropped, a 
corresponding folder is created in TechDoc if it does not exist. Then any documents in 
that folder are created in TechDoc under the corresponding folder. Then the process is 
repeated for any child folders until the entire folder tree and documents under it have 
been created in TechDoc. This allows you to organize your documents in a folder tree 
and maintain that folder tree when it is dropped onto the client. 
 

5.3. Special Input Handling 

As discussed in the previous section on bulk loading, document numbers can support 
client auto-numbering and server auto-numbering. This special input handling is used on 
the Create Document screens and Profile screens to tell the client to fill in a particular 
field with a calculated value. In addition to document auto-numbering, the following 
special input handling is also available. 
 

5.3.1. Document Title 

The document title has a dropdown box that allows you to choose alternate ways to 
provide a title. Currently, the only option is to use the source file name as the title for 
the document. If you do not wish to use the dropdown box, you can still leave the title 
blank or manually enter a specific title to use. Note that this ability is not available when 
modifying a document. 
 

5.4. Profiles 

Profiles come into play when you are creating documents. We discussed profiles earlier 
and how creating a profile is similar to creating a document except that when you are 
finished, any document metadata that you entered is simply stored in the profile. Then 
if you select a profile, when you start creating new documents, the Create Document 
screens are pre-filled in with any metadata contained in the profile. Note that you still 
have the chance to change any of the metadata before the actual creation process 
begins. 
 
For example, let's say that you have financial records like receipts that you're putting 
into the Document Manager all the time. The receipts always have a doc type of Receipt, 
a doc category of Financial, you are the point of contact, they always belong to your 
organization, and you always have to add the same 5 keywords to them. This can take a 
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lot of time to re-enter all of this information repeatedly, not to mention how 
monotonous it is. A situation like this is perfect for a profile. 
 
To create a profile for the example above, you'd click "Create Profile" from the profiles 
menu. Enter a profile name such as Receipts and select the doc type, doc category, 
organization and even the reason if it's usually the same. Click the Next button, and fill 
in all of the information for the keywords. After you have all of the information filled in, 
click the OK button. The client will then save all of this information under a profile 
named Receipts. 
 
Now any time you have to enter one or more receipts, it will be much easier and 
quicker. Simply select the Receipts profile from the profiles box in the upper right-hand 
corner of the main client window and start the create document process. You'll notice 
that all of the information from the profile has been pre-filled in for you on the Create 
Document window so all you have to do is enter a document number, click Next and 
then OK. Keep in mind, profiles can be modified and deleted at any time by selecting a 
profile from the profiles combo box, and selecting either "Modify Profile" or "Delete 
Profile" from the profiles menu. 
 
That saved a little bit of time, but you have 100 receipts to enter every day. Auto 
numbering (described in section 5.2) could also be used here. You could use one of two 
methods: 
 

• If the Document Manager that you are connected to has document auto-
numbering enabled, when you create your profile, simply leave the document 
number blank. The when you select the Receipts profile, all of the information is 
filled in and the document number is left blank. Then when you click the OK 
button to create those 100 receipts, the server will automatically assign number 
for you and boom, you are finished. 

• If the Document Manager doesn't support auto doc numbering, you can always 
take advantage of client auto-numbering. In this instance, it might not make 
sense to fill in the document number in the profile because a client auto-
numbering pattern can only be used a single time. For example, if you entered 
the document number Receipts-### on the receipts profile, the first time you 
used the profile and created documents, documents numbered Receipts-001, 
Receipts-002, …, Receipts-100 would be created. The next time you tried to use 
the profile and create documents with the same Receipts-### client auto-
numbering pattern, the client would inform you that documents already exist 
with those document numbers. Most of the time it's better to determine a 
client-numbering pattern that can be used to help provide new and unique 
document numbers. For instance, you could always use a date like 
Receipts-2011-02-28-###. If you only enter receipts once a day, the client-
numbering pattern should always be unique. 
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Lastly, you may have noticed in the profiles box there are two options listed: (No profile 
selected), and (Use last inputs). The first option, (No profile selected), simply means that 
no values will be pre-filled in when the Create Document window is displayed. The 
second option, (Use last inputs), is a special profile that the client creates for you. This 
profile remembers whatever you input on the Create Document window the last time 
you created document(s). The next time you create a document, the last inputs profile 
will fill in everything you entered last time. If you make any changes, the last inputs 
profile will remember these changes and use them next time you create a document. 
 

5.5. Search Folders 

We talked briefly about search folders in the beginning of this guide. A search folder is 
nothing more than a set of documents that match a set of search criteria that you 
specify. When you create a search folder, you enter all the document metadata that you 
wish to search on. When you click the OK button to save the search folder, the client 
stores the search folder information with the current connection's settings and places 
an entry for it under the "Search Folders" folder in the folder tree. Now any time you 
want to search or re-search for documents that belong to a certain organization, or 
were created by a particular individual, you can click on that search folder and the client 
will perform a search on the Document Manager and display any documents that 
match. 
 
This can be useful for many reasons. Perhaps you have to work on schematic documents 
often and schematic documents always have a doc type of Schematic. You can create a 
search folder that is named Schematics and searches for documents that have a doc 
type of Schematic. Now every time you click on the Schematics search folder, all of the 
schematic documents from the Document Manager will be displayed. With all of these 
documents showing in the same search folder, it is easy to select them all and change 
associations on all of them or even download the latest revision of them to a folder on 
your hard drive. 
 
Search folders can be created by right clicking on the "Search Folders" folder in the 
folder tree and selecting "Create Search Folder", or by selecting "Create Search Folder" 
from the file menu. On the Create Search Folder window, give the search folder a name 
and enter any data that you want to search on. Click the OK button to save it and you're 
finished. You can modify and delete search folders any time by simply right clicking on 
the search folder and selecting either Modify or Delete. 
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6. Tools 

The TechDoc Client comes bundled with a few tools that used to be standalone pieces of 
software. These tools can be accessed by clicking the Tools menu item on the top menu 
bar. Each tool is detailed in the following sub-sections. 

6.1. Doc Deleter 

The Doc Deleter tool can be used to delete a large number of documents using a single 
file that specifies all of the document numbers for each of the documents. Often times a 
list is put together when a large group of documents is up for deletion. After the list has 
be thoroughly reviewed, this tool can be used to delete all of the documents in a single 
action. 
 
The Doc Deleter supports two types of input files for deleting documents. You can 
specify either a CSV file that has only one column, no column heading and only one 
document number per row or a TXT file that has only one document number per line 
and no additional spaces or separator characters. 
 
The new version of Doc Deleter bundled into the TechDoc Client works just as the old 
standalone one does except the screen of the tool looks a bit smaller as there are fewer 
fields. Since the TechDoc Client already handles the connection to the Document 
Manager for you, all you need to do is simply specify the file of documents to delete, 
enter a reason, and click the OK button. Once the delete job begins, the TechDoc Client 
will block all input until the job completes (as it does with every other action). 
Additionally, the status of the delete job can be viewed on the main window by looking 
at the status message area on the lower left-hand corner of the window. 

6.2. Doc Fetcher 

The Doc Fetcher tool can be used to fetch large number of documents using a single file 
that specifies all of the document numbers for each of the documents. 
 
The Doc Fetcher supports two types of input files for fetching documents. You can 
specify either a CSV file that has only one column, no column heading and only one 
document number per row or a TXT file that has only one document number per line 
and no additional spaces or separator characters.  
 
When deciding what to fetch, you have a number of options. First, choose which gen 
you want: latest generation, latest revision, or either. Second, choose which gen type 
you want: default, native, rendered, or either. The table below will help you decide 
which combination of the options to choose: 
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   Which Gen 

Gen Type Latest Gen Latest Rev Either 

Default Fetches the native file for 
the latest gen. 

Fetches the rendered file 
for the latest rev. If there 
is no rendered file, then 
the native file for the 
latest rev is fetched. If 
there is no released gen, 
the document is skipped. 

If the document has been 
released, use the Latest 
Rev rules on this row. 
Otherwise, use the Latest 
Gen rules on this row. 

Native Fetches the native file for 
the latest gen. 

Fetches the native file for 
the latest rev. If there is 
no released gen, the 
document is skipped. 

If the document has been 
released, use the Latest 
Rev rules on this row. 
Otherwise, use the Latest 
Gen rules on this row. 

Rendered Fetches the rendered file for 
the latest gen. If there is no 
rendered file, the document 
is skipped. 

Fetches the rendered file 
for the latest rev. If there 
is no released gen or no 
rendered file, the 
document is skipped. 

If the document has been 
released, use the Latest 
Rev rules on this row. 
Otherwise, use the Latest 
Gen rules on this row. 

Either Fetches the rendered file for 
the latest gen. If there is no 
rendered file, the native file 
for the latest gen is fetched. 

Fetches the rendered file 
for the latest rev. If there 
is no rendered file, the 
native file for the latest 
rev is fetched. 

If the document has been 
released, use the Latest 
Rev rules on this row. 
Otherwise, use the Latest 
Gen rules on this row. 

 
The new version of Doc Fetcher bundled into the TechDoc Client works just as the old 
standalone one does except the screen of the tool looks a bit smaller as there are fewer 
fields. Since the TechDoc Client already handles the connection to the Document 
Manager for you, all you need to do is simply specify the file of documents to fetch, 
select the generation and type you want, and click the OK button.  
 
Once the fetch job begins, the TechDoc Client will block all input until the job completes 
(as it does with every other action). Additionally, the status of the fetch job can be 
viewed on the main window by looking at the status message area on the lower left-
hand corner of the window. 
 

7. Accessibility 

The TechDoc Client is written in Java. On Windows, Java provides accessibility support 
via the Java Accessibility Bridge (JAB). JAB support must be enabled on Windows and the 
assistive technology product must support JAB such as one of the following products: 
JAWS, NonVisual Desktop Access (NVDA), SuperNova, Window-Eyes, and ZoomText. On 
Windows, you can enable Java Access Bridge through the Control Panel: 
 

1. Go to Start > Control Panel > Ease of Access > Ease of Access Center. 
Alternatively, press Windows logo key+u to access the Ease of Access Center. 
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2. Select Use the computer without a display. 

3. In the section Other programs installed, select the check box Enable Java Access 
Bridge (you may have to scroll down). 

More DocuBrain-specific accessibility information can be found at: 
 

https://docubrain.com/accessibility 
 
More Java-specific accessibility information can be found at: 
 

https://docs.oracle.com/javase/8/docs/technotes/guides/access/index.html 
 

8. Suggestions and Feedback 

We hope you enjoy the TechDoc Client but if you use it frequently, we also expect you 
to say, "I like the TechDoc Client but I wish it could …" If you find yourself in this 
situation, please let us know by sending us email at suggestions@docubrain.com 
 
If you do happen to find a problem, please feel free to use the same email above. While 
we do prefer suggestions and compliments, we also accept criticism (preferably 
constructive :-) 
 
At Prevo Technologies, Inc., we take the quality of our products very seriously. If you do 
find an issue or something that you feel can be improved upon in the TechDoc Client, 
please let us know. 
 

https://docubrain.com/accessibility
https://docs.oracle.com/javase/8/docs/technotes/guides/access/index.html
mailto:suggestions@docubrain.com
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